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“Page-O-Links”
• Watts Digital Home Page (Products & Services):
https://wattsdigital.com
• Join my mailing list to receive my Watts Digital Photoshop “Quick Tip” Newsletter:
Click Here to Join
• Photoshop free live Meetups online:
https://wattsdigital.com/free-live-meetups-online
• “Not Just Another Photoshop Book”:
http://www.amazon.com/dp/B07HNLS1Q2
• Free Useful Downloads:
https://wattsdigital.com/free-useful-downloads
• Free “Photoshop 101” Videos:
https://wattsdigital.com/free-photoshop-101-videos
• Free Photoshop YouTube Videos (Don’t forget to subscribe & “like”):
https://www.youtube.com/user/wattsdigitalvideos
• Small Group Workshop Meetups:
https://wattsdigital.com/small-group-workshops
• Blog Home Page (Educational):
https://blog.main.wattsdigital.com
• Blogpost: What is a Master File, and why do I need one?
https://blog.main.wattsdigital.com/photoshop-master-file-creation/
• Blogpost: Photoshop vs Lightroom? Wrong Question! (Link to Part 2 & 3 in this blogpost)
https://blog.main.wattsdigital.com/photoshop-vs-lightroom-wrong-question/
• Blogpost: The Philosophy of RAW: (with link to new v 12.3 features video)
https://blog.main.wattsdigital.com/the-philosophy-of-raw/
• Blogpost: Camera RAW 12.3: RADICAL Changes to the User Interface - with VIDEO
https://wp.me/p9BaP-MN
• Blogpost: Layer Mask Concepts & Basics, Part 1:
https://blog.main.wattsdigital.com/?p=2283

Links
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RAW Fundamentals for Photoshop

One of the most misunderstood (and mis-used!) concepts in digital post-processing is how to properly
work with RAW files.
What to do with all that digital information? How do you work with the format correctly & maximize your
image’s potential?
When enhancing your image from RAW, what are the “Goals”, and why? What the heck are you even
aiming for?
You should be shooting in Camera RAW for your important work -- the results are worth it! The more
digital information you’re able to capture when you shoot, the more information you have to effectively
create your image.

The Master File and Workflow
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The Master File and Workflow

If a picture is truly worth a thousand words, then here’s an overall visual representation of the Workflow
Chart that I recommend you adopt (from my book) – notice that your Workflow centers on creating a Master
File.

Creating a Master File is NOT for every image: it’s for those images that you want to spend time with,
doing all that’s necessary to make your image “pretty”. Here’s where you pour your artistic “blood, sweat
and tears” into your image.
What is a “Master File”? It’s a 16-Bit, un-flattened, un-sharpened, un-cropped, un-resized file designated
as such in its file name.
Why create a Master File?
•

It’s Multi-purpose: Use it to create separate files for a specific print size or printer, for the Web, for
magazine output, etc. and you’ll stay consistent between those files.

•

It’s easily correctable: for color, contrast, cropping, enhancements, etc. non-destructively (loss of
digital information).

•

Sharpening is applied according to your print size: Let’s say that your Master File is created from
a RAW file – It might be around 11”x16.5” at 300 ppi – If you sharpen for this size and reduce the
file to prep for a 4x6 print, it will be over-sharpened.
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What is RAW, and why do I need it?

•

A Camera RAW file contains unprocessed, uncompressed 16-bit data from your digital camera.
It’s just information, but lots of it. It isn’t really a file “format”, like JPG or TIFF. It also doesn’t have
a Color Space (discussed in Class 1 & Class 5).

•

You can’t open a RAW file directly in Photoshop: You must first work with it in The Adobe Camera
RAW Plug-in (ACR) before “sending” it to Photoshop. By the way, ACR is a separate program, but
included with (and “linked to”) Photoshop.

•

You should be shooting in Camera RAW for your important work -- the results are worth it!
The more information you are able to capture when you shoot, the more information you have to
effectively create your image.

•

Tonal Compression: This was discussed in Class 1, but this is a great time to review, with a
visual diagram - This is the inevitable reduction /degradation of the original scene from your eyes
to the print. It’s pure physics - the range of colors reproduced shrinks throughout the process.
Let’s say, for example, that our eyes see 100 shades of red. The camera, shot in RAW, may see
70 shades. Then Photoshop may see 60 shades of red, and the printer may only print 45 shades
of the original 100 shades available.

So, how can you minimize some of the effects of tonal compression? Three things:
1) - Shoot in RAW (or scan in 16 bit)
2) - Use a proper Color Working Space in Photoshop (discussed in Class 1 & Class 5)
3) - Have your Color Management “house” in order
(discussed in Class 5)
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A RAW file is different from a JPEG in 2 major respects:
1) There’s much more information in RAW (16 bit vs. JPG’s 8 bit)
2) There’s automatic “file compression & processing” built into the creation of a JPG,
whether you want it or not.

•

16 bit vs. 8 bit:
More information is a very good thing in photographic capture. Bit Depth is like the Earthquake
Richter Scale: it’s logarithmic - - a 6.0 earthquake is twice as powerful as a 5.0 earthquake, not
just 20% more powerful, as the numbers on the scale would seem to indicate. Likewise, a 16bit file is NOT twice as much information as an 8-bit file: it’s hundreds of times more
information.
(JPG) 8 Bit: 256 values of each color x 3 (RGB) = 17.7 Million combinations of RGB
(RAW) 16 Bit: 65,000+ values of each color x 3 (RGB) = 281 Trillion combinations of RGB

•

What is an .xmp file?
It’s a separate (“sidecar”), tiny, glorified “text” file that contains “metadata” – you never need to
directly open it.
Think of it as the “instructions” for all of that RAW information (which is never directly “changed”).
It’s generated as soon as you make any “modifications” to your RAW file, and saves those
“instructions” in the same folder as your RAW file.
A few things to remember:
1) - If you back up your RAW file, back up your .xmp file, too; it’s in the same
folder/location as your RAW file.
2) - If you’re working in “Bridge” and can’t see the .xmp file, simply go to “View” Menu ->
“Show Hidden Files”.
3) - If you want to start over with your original “as shot” RAW capture, simply “trash” the
.xmp file (very rare!).

•

If your Camera shoots, RAW + JPG, then you should do so ...
It takes up little in memory, and gives you a quick “look-see” image that’s been “processed” for
contrast, color, etc. (albeit by a computer chip!). Oh, and I frequently hear folks say “My JPG looks
better in Bridge or Lightroom!” - - read on, and you’ll never believe that again!
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Adobe Camera RAW Plug-in (ACR) to Photoshop Workflow
Adobe Camera RAW plug-in (ACR) to Photoshop - what should be done in each
program?
•

Generally, I’d suggest that you make as many global Hue, Saturation and Brightness corrections
as you can in the Adobe Camera RAW plug-in (ACR), following the “Goals” shown below.

•

Further, I’d also suggest doing ALL contrast adjustments, localized corrections of any kind, “finetuning”, cropping and sharpening in Photoshop - you can then take advantage of the power of
adjustment layers and layer masks, “fine-tuning”, cloning, cropping, sharpening, and much more.

•

While it’s true that you’ll spend a bit more time in your overall Photoshop Workflow by shooting in
RAW, it’s really not that much more - you’ll probably spend a lot less time in Photoshop by
spending a few more minutes in ACR first – and the results are truly worth it!

…so, the four “Goals” are to bring your final RAW image into Photoshop:
• Slightly Dark or Under-Exposed - - It’s easier to lighten in Photoshop …
• Slightly Low or “Flat” in Contrast - - It’s easier to increase your contrast in Photoshop …
• Slightly Over-Saturated - - It’s easier to de-saturate in Photoshop …
• Best Overall Color Balance - - You can “fine-tune” individual areas in Photoshop …

•

Why these four “Goals”, you ask? Following these 4 “Goals” will bring LOTS of information
from your digital capture into the “visible spectrum” (and hence your Master File in Photoshop).

•

Further, it provides “headroom”, or a “margin of error” – it’s always better to have more
information than not enough, and information is king in post-processing.

Keep in mind that by using these four “Goals” your objective is NOT to make a perfect image in ACR
- which is what most people try to do, including Lightroom users in the “Develop” Module - and you
simply can’t (see blogpost on “Lightroom vs Photoshop? Wrong Question!”) ...
By using these four “Goals”, you’ll take advantage of the strengths of both ACR and Photoshop in
your overall workflow to end up with your final desired “killer” image (via your Master File).

•

What are those strengths? ACR is designed to get as much digital information as you can out
of your digital capture, and Photoshop is the industry standard in using that information for the
best possible (and most flexible) results.
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Points to Remember:
•

There are actually quite a few advanced tools in the ACR Plug-in. However, both in Workflow
and the spirit of K.I.S.S. (Keep It Super Simple), you should NOT be using the more advanced
functions – it’s quite possible that you, like me, will never use them!

•

Other than the “Edit” Tool (discussed later), I never use any of the various tools and brushes in
ACR (I call them “gee-whiz” functions) – 3 reasons:
1) There’s not a true “History” Panel to fall back on (like in Photoshop) if I don’t like what I see.
2) There are no “Layers” in ACR.
3) Photoshop does a much better job of doing what most of these “gee-whiz” functions in ACR do.

•

You should strike a balance of time spent with your file in both ACR and Photoshop, using the
strengths of each program. Typically, I’ll spend 20% to 25% of my “file” time in ACR, with the
balance in Photoshop.

Key Point: The Histogram shows those pixels brought into the "visible
spectrum" of light from your original "bucket" of RAW Capture.
• By bringing your file from ACR into Photoshop following the four “Goals”, your
histogram in Photoshop should reflect it (depending on the subject matter,
of course), with a bias of extra pixels to the left-hand side, similar to the Levels
dialog box shown - slightly underexposed, with plenty of “headroom” (room for
adjustment), particularly in the highlights.
• This will bring pixels from your RAW capture into the “visible spectrum” of light,
and avoid digital “clipping”. By the way, this concept is called “Expose to the Left”
(feel free to run an internet search on it for more).

If it was good enough for Ansel Adams, it’s good enough for me …
Ansel Adams was not only a ground-breaking
photographer, but he re-defined what to do with
your image AFTER you’ve shot it (“postprocessing”). By doing so, he was a pioneer in
turning printed photographs into an art form.
Using the Zone System, Adams & his
contemporary Fred Archer were famous for
exposing & chemically processing their negatives
so that they were slightly low in contrast &
slightly under-exposed, which resulted in more
detail in the highlights as well as the shadows
– just like 2 of the “Goals” stated above (the
other 2 goals are exclusive to color images).
Think of adjusting your RAW file in the same
way – but instead of using a negative &
chemistry like Ansel Adams & Fred Archer
did, we’re processing our RAW File (the ”negative”)
using Adobe Camera RAW (the “chemistry”).

“Moonrise, Hernandez, New Mexico”

from anseladams.com
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More on the “Moonrise” Sequence from the previous page ...
• Original Negative: Using the Zone System, the initial capture is slightly underexposed, and
retains detail in the highlights & shadows (low in contrast) - think original RAW Capture.
• Contact Sheet: The contact sheet reveals the low-contrast nature of the original capture &
chemical processing technique - think "first look" in Camera RAW.
• Initial Print: Although low in contrast, the initial print shows all sorts of detail in the highlights as
well as the foreground - think “after adjusting” in Camera RAW.
• Final Print: This famous print shows how much can be done with the original capture, truly
giving it that majestic "pop" - think “after adjusting” in Photoshop.

To see an enlargeable version of the Ansel Adams composite on the
previous page, visit this blogpost (near the bottom), or use the QR code at
the right:
“The Philosophy of RAW”
https://blog.main.wattsdigital.com/?p=2215

ACR Plug-in to Photoshop Evolution:
• Once you’ve made all of the necessary adjustments to your RAW file following the 4 “Goals”, press
the “Open” button on the bottom right of the ACR Workspace. You’ll notice 3 things will happen:
1) - ACR Plug-in Closes
2) - Your file opens in Photoshop
3) - A .xmp file is generated, and saved in the same folder as your RAW file
• Notice the Filename and File Extension’s evolution in Photoshop:
1) When you bring the file into Photoshop from ACR, the file
extension (.NEF & .CR2 or similar) leads you to believe it’s still a
RAW file (for the propeller-heads amongst us, it’s not really – it’s
a 16-bit hybrid TIFF).
2) Next, you save your image as a Master File (with the “_M” at
the end of the filename) – your image shows up with the “.TIFF”
or “PSD” extension, depending on what you select.
•

Here’s where you save your image to begin building your Master File
– see the Workflow Chart for more. Now you can task your Master file (discussed earlier) for
many uses – You can crop, sharpen and convert to 8-bit for printing on your inkjet printer or
through a custom lab; you can reduce the size and PPI to save as a JPG for the web, and so on.
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Using Camera RAW Filter for “Non-RAW” Files in Photoshop

Using Camera RAW Filter for “Non-RAW” files in Photoshop
You’ll notice from the Workflow Chart on page F that I run everything (RAW and non-RAW files) through
Adobe Camera RAW for maximum results – but opening a non-RAW file in the ACR plug-in can be
problematic.
• Not to be confused with the Adobe Camera RAW (ACR) “plug-in” (which is technically a separate
program), there is a “filter” in Photoshop CC that gives you access to some of the better features of ACR –
It’s called the Camera RAW Filter, and works on your “non-RAW” files such as JPG, TIF, and so on.
• I incorporate this Filter into my regular “non-RAW file” workflow (particularly for “problem” files), and I’ve
drastically improved overall quality – plus, I’ve frequently reduced the total amount of time I spend working
on an image in Photoshop.
Here’s how to do it:
1) Use this Filter after you’ve opened your “non-RAW” file in Photoshop (JPG, TIFF, PSD, etc)
2) Create a Background Copy first – to do this, with your Background Layer active, go to “Layer” ->
“Duplicate Layer …”
3) Make your Background Copy active by clicking on it once, then go to the “Filter” menu, then
choose -> “Camera RAW Filter …” - now follow the steps in the Workflow Chart.
Minor Disadvantages
•

It’s limited to the bit depth of the original non-RAW file – If you open a JPG (8-bit), it will stay 8-bit.

•

Lens corrections is unavailable – there are no lens profiles like in the ACR plug-in.

•

Unlike the ACR plug-in (which generates an .xmp file), the adjustments you make in Camera
RAW Filter are not saved - that’s why you use it with a background copy so it’s saved separately
within your Master File.

•

If you start with a JPG, you’ll need to save your final version as a TIFF or PSD, as JPG’s cannot
be saved with Layers.
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The ACR Workspace
Accessing the ACR Plug-In:
The easiest way to access the Adobe Camera RAW (ACR) Plug-in is to go to the “File” menu  “Open…”
in Photoshop – Choose a RAW file, and the ACR Plug-in Workspace will automatically open.

Set your Preferences:
1. Settings: – If necessary, click on the “gear” icon in the upper right to access. But I’d recommend
leaving everything at the default settings. When you need to change your “Workflow
Options” (also available in the “Settings” menu), simply click on the area shown instead in the
graphic above.
2. In the "Workflow Options" Menu, choose:
•
•
•

•

"Adobe RGB (1998)" for "Space"
“16-Bits/Channel" for "Depth"
For "Image Sizing", uncheck "Resize to Fit" -- This will give you a file equal to the native
size of your camera sensor: It’s better to use Photoshop, not the RAW plug-in, to enlarge
your image to the desired size, as the sharpening algorithm in Photoshop is so much
better.
"300 pixels/inch" for "Resolution".

Unless you have RAW files from more than one camera, you’ll only have to set this once.
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ACR Workspace features (shown clock-wise in diagram on previous page):
• Click on the “Expand / Collapse Panel” icon to open & close “Panels” – – If necessary, you
can edit the “Panel” behavior in “Settings -> General”: I use the default “Single Panel” mode, as
only one “Panel” is open at a time, and the others close – WAY less clutter!
• Toggle Full Screen Mode: to avoid distractions in the background of your screen, click on the
double-sided arrow icon in the upper right to expand – or use the Speed Key “F”.

• If you follow the Goals of RAW file enhancement, you’ll need only one “Tool” (the “Edit” tool),
and four essential “Panels” (shown with arrows in the diagram on the previous page).
You can pretty much ignore the other “Tools” & “Panels”- - it’s “gee-whiz” stuff, and more than
likely you’ll never need them. Besides, you can perform these functions in Photoshop (using your
Master File) with dramatically better results - Remember, K.I.S.S. (Keep It Super-Simple).

• The Per-Panel Preview Icon (hereinafter referred to as the “Eyeball”): if a “Panel” is edited,
then the Eyeball is highlighted - if it’s grayed out, there are no edits in that “Panel”. For example:
in the diagram on the previous page, only 3 “Panels” have been edited.
• The Eyeball shows / hides the edits of the chosen “Panel” - just click & hold to
see “before”, and release to see “after”.
• Toggle to Default Settings (“Preview” Toggle): this shows before / after views of ALL
corrections made to your RAW file – not just for an individual “Panel”.
• “Before / After” Views: press & hold for options / preferences, click for your preferred view –
side-by-side, top / bottom, etc. FYI, the Speed Key is “Q”. By the way, I rarely use this function but if you do, you can make adjustments to your file while in this view.
• Filmstrip: simply click the icon shown to hide / reveal the Filmstrip – OR, click & hold for
options. This is a handy feature if you’re processing multiple RAW files. I definitely don’t use it all
of the time, preferring instead to see my image a bit larger in the Workspace.
(Not shown in diagram):
• Zoom Tool: The Zoom Tool is the default cursor that shows up in your image. If you click on
your image, it enlarges to 100% – – click again, and it returns to “Fit to View”
• All of the most popular Speed Keys and Navigation Tools that are available in Photoshop are
also available in ACR
_____________________
• When all of your adjustments are completed in ACR, click on the "Open" button. As
mentioned earlier, 3 things happen when you do:
1) ACR closes,
2) your image opens in Photoshop,
3) an .xmp file is generated (and saved in the same folder as your RAW file
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ACR in Action

Important: as you work through this chapter, keep in mind the critical “Goals” discussed in Chapter 19.

How to Check for Clipping:
Clipping is the unwanted elimination and usage of digital
information (pixels). Because a RAW file has an incredible
amount of digital information, it needs to be optimized, and critical
pixels need to be brought back into the “Visible Spectrum” (See
Chapter 19). As you do so, you’ll be using the Clipping Warnings
in ACR, similar to the ones in Levels (Class 2).
By making the proper adjustments in ACR with the Clipping
Warnings turned on, you’ll take advantage of the full range of
tonal values available to you in your image - without “clipping” pixels.
• Toggle the Clipping Warnings on and off a few ways:
- Turn the "Clipping" Toggles on by clicking on the square boxes with the triangles in it in
the upper corners of the histogram.
- The square box on the left will activate the Shadow Clipping Warning, and the square
box on the right will activate the Highlight Clipping Warning.
- You’ll know that the clipping toggles are active when the small box has a black
pinstripe around it.
- You can also hold down the "Option" key in Mac (" Alt" key in Windows) while adjusting
the appropriate sliders in the “Exposure / Contrast” group (discussed shortly)

• To Correct for Clipping: With the Clipping Warnings activated, move the appropriate sliders in
the “Exposure / Contrast” group (discussed shortly) until the clipping masks disappear (or as
close as you can, if it’s not possible to completely eliminate clipping).
• Highlight Clipping is typically shown in red, and Shadow Clipping is typically shown in blue.

About the Panels:
There are only 4 “Panels” that I use on a regular basis, each described in detail below. You
can pretty much ignore the other “Panels”- - it’s “gee-whiz” stuff, and more than likely you’ll never
need them. Besides, you can perform these functions in Photoshop (using your Master File)
with dramatically better results - Remember, K.I.S.S. (Keep It Super-Simple)!
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1) The “Basic” Panel:
The "Basic" Panel is where you'll do the vast majority of your work in ACR by moving the Adjustment
Sliders.
•

It’s important to get in the habit of making small adjustments at first, then using the "Preview"
toggle to see your results as you go along.

•

You'll notice that the horizontal line that forms each slider is a visual representation of what that
slider can accomplish, color and density-wise. For example, the "Exposure" sliders' horizontal line
goes from dark to light, the "Tint" sliders' horizontal line goes from green to magenta, and so on.

•

Photoshop has grouped the adjustment sliders in the “Basic” Panel into 4 groups, by function:
1)
2)
3)
4)

Exposure / Contrast Group
Color Balance Group
Edge Sharpness Group
Color Intensity Group

•

Start by adjusting the “Exposure / Contrast Group” FIRST in the “Basic” Panel - - As
discussed previously, it‘s imperative to work on each group in the order shown above: Exposure
/Contrast should be adjusted first, followed by the Color Balance – not the other way around! See
the Workflow Chart.

•

There are 3 controls at the top of the “Basic” Panel: “Auto”, B&W” and “Profile” - in the spirit of
K.I.S.S., I strongly recommend you IGNORE all 3 controls, and leave at their defaults.

____________
The “Exposure / Contrast” Group:
o

Exposure: This affects mostly the mid-tones of your image. Move to the left to darken your image,
and to the right to lighten.

o

Contrast: I rarely use this slider - You’ll get better results by adjusting your final contrast in
Photoshop. I generally leave it at the default settings - or, more than likely, even reduce the values.

o

Highlights: This slider will recover highlights that are washed out. Move the slider to the left to
increase the highlight detail.

o

Shadows: Move the slider to the right to open up shadow detail.

o

Whites: This slider will recover extremely bright details. I use it after using the Highlights slider to
“fine-tune” - but don’t let your whites get too “muddy” or gray!

o

Blacks: Move the slider to the left to increase the amount of black in your image. Be careful with
this one --It's easy to block out shadow detail if you use too much of it.
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The “Color Balance” Group:
•

White Balance: It’s been my experience that you get better results with manual adjustments – but
you can use these “presets” as a guide. These are presets for the "Temperature" and "Tint" sliders,
discussed below. From the drop-down menu, you can choose from a number of presets. This will
also give you an idea of how the “Temperature" and "Tint" sliders work and interact. Once you
move any slider manually, this box changes from “As Shot” to “Custom”.

•

Temperature: Move this slider to the right to warm up the color of your image (adds a yellow cast),
and move it to the left to cool your image down (adds a blue cast).

•

Tint: Move the slider to the right to increase the overall magenta bias, and to the left to increase
the overall green bias.

The “Edge Sharpness” Group:
•

Texture: This can make up for the inevitable failure of digital capture challenges with sharpness it also increases Contrast, so be careful! 10 to 15 units are usually more than enough to get the
job done.

•

Clarity & Dehaze: I NEVER use these sliders - both of these are also “edge sharpening” tools,
like Texture. Consider Texture to be a fine adjustment, Clarity to be a medium adjustment, and
Dehaze to be a coarse adjustment. Both of these controls radically increase the contrast, which
defeats one of the “goals” discussed in Chapter 19 - bringing your RAW file into Photoshop low in
contrast.

The “Color Intensity” Group:
•

Vibrance: This is “Saturation on Steroids”, preferred to Saturation below. It’s not unusual for me
to add 30+ units.

•

Saturation: I rarely use this, preferring the Vibrance slider above instead.

____________

2) The “Color Mixer” Panel:
This functions similarly to the “Hue / Saturation” Adjustment Layer, discussed in Class 2.
Options: you’ll notice that there’s a drop-down menu called “Adjust”, which gives you the choice
of either an “HSL” or “Color” mode. You’ll get the same results, regardless of which mode you
choose. AND – if you make changes in one mode, those changes show up in the other mode.
• If you choose “HSL” – – this has separate tabs for Hue, Saturation, & Luminance
– with the eight colors in each tab. Think of it this way – choose which tab you need first
(H, S or L), then adjust your particular color(s) within that tab.
• If you choose “Color” – – the HSL controls are conveniently grouped together in
whatever Color you’ve chosen. This is really handy if you only need to adjust the HSL of
a particular color. Think of it this way – choose the Color first, then adjust the HSL for
that Color only, all in one convenient place.
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3) The “Optics” Panel:
Under the ”Profile” sub-tab, choose “Remove Chromatic Aberration” and “Enable Profile
Corrections”. On newer cameras, the profile for your lens should automatically be chosen - you
can, if you wish, check the profile details by clicking on the triangle to the right, but it’s usually not
necessary.
I’ll generally apply the profile, mainly because of parallax correction & how it opens up and evens
out the corner density / fall-off. There are a few instances where I wouldn’t apply it: images from
a specialty lens (such as a fisheye, etc.), or perhaps I just like the image “as-is”.

____________

4) The “Detail” Panel:
Adjust Noise Reduction as necessary – rare for low ISO images, necessary for high ISO images
(over 1600+, depending on the camera). Start with low values (10 to 25) using the” Luminance”
Slider, and adjust at 100% magnification / enlargement.
Personally, I’ve found Topaz DeNoise (https://topazlabs.com/denoise-ai-2/) to be a much better
product, and rarely use the Noise Reduction built into Photoshop.

____________

Processing Multiple RAW files
If you open multiple RAW files at the same time, the “Filmstrip” opens on the
left side of your workspace (or bottom, depending on your “Filmstrip” options).
You’ll see thumbnails of your RAW files.
•

Clicking on a thumbnail highlights it, making it the “active” image.

•

Once all your adjustments are completed, and BEFORE pressing the
“Open” button at the bottom-right, right-mouse click on any thumbnail and
choose “Select All”. All of your images should be highlighted.

•

If you only select only one image and press the “Open” button, that image
opens in Photoshop and closes ACR. Don’t worry about all of your work
in the other images – an .xmp file is generated for each of them.

____________

Link to free Online Meetups
Join us for FREE live & online Meetups, including one specifically
for “RAW Fundamentals” - - in these Meetups, you’ll see methods
taught in this book “come to life”!
https://www.meetup.com/San-Diego-Photoshop-for-Photography/
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The ACR-to-Photoshop Evolution Shown Visually
If a picture is worth a thousand words, then this
series of screengrabs of two different images will
visually show you the evolution from the Original
RAW Capture, to the Optimized Master File in
Photoshop:

This image is the original RAW
capture opened and un-edited in
ACR. See the Workflow Chart,
“Open File in ACR”, in my book.

1

This image is the RAW capture
optimized in ACR following the
“Goals”, ready to open in
Photoshop See the Workflow
Chart, “Optimize File in ACR”,
in my book.

2

This image is the optimized
Master File in Photoshop, ready
to be purposed for print, web,
etc. See the Workflow Chart,
“Optimize Master File in
Photoshop”, in my book.

3
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This image is the original RAW
capture opened and un-edited in
ACR. See the Workflow Chart,
“Open File in ACR”, in my book.

1

This image is the RAW capture
optimized in ACR following the
“Goals”,, ready to open in
Photoshop See the Workflow
Chart, “Optimize File in ACR”,
in my book.

2

This image is the optimized
Master File in Photoshop, ready
to be purposed for print, web,
etc. See the Workflow Chart,
“Optimize Master File in
Photoshop”, in my book.

John M. Watts Jr.

3
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Optimize RAW File in ACR (Section 2 of primary “Workflow Chart”):
A) Open your RAW file in ACR (or your “non-RAW” file in Camera RAW Filter in PS)
B) Adjust the “Optics” Panel (Except Camera RAW filter) - Pg 14
C) Adjust the “Basic” Panel – Exposure and Contrast first, then Color - Pg 12-13
D) Adjust the “Color Mixer” Panel - Pg 13
E) If necessary, adjust the “Detail” Panel for Noise Reduction - Pg 14
F) Open in Photoshop (except in Camera RAW Filter in PS)
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